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Sažetak 

Temom “Primjena Photoshopa u digitalnoj fotografiji” proučava se primjena Photoshopa u 

kreativnoj i tehničkoj izradi digitalnog zapisa fotografske slike. Obrada fotografije je relativno 

širok pojam koji obuhvaća bilo koju vrstu promjene originalne fotografije, na način da se dođe 

do minimalnih izmjena (retuširanje, izmjena ili korekcija boje, kopiranje i izrezivanje pojedinih 

dijelova itd.), pa sve do dobivanja posve drugačije i nove fotografije nastale kombiniranjem 

više fotografija ili segmenata. Da bi se takve korekcije mogle izvršiti potrebno je malo pojasniti 

što je Photoshop i koje su njegove mogućnosti te alati potrebni za izradu spomenutih fotografija. 

Također, ako će biti spomenuti Photoshop i digitalna fotografija, onda će biti navedeni i neki 

detalji o digitalnoj fotografiji, što je digitalna fotografija, njezina kratka povijest te će biti 

spomenuti prednosti i mane spomenute fotografije u odnosu na klasičnu kako bi završni rad bio 

upotpunjen i lakše razumljiv.  

KLJUČNE RIJEČI: Photoshop, digitalna fotografija, obrada fotografije 

 

 

Summary 

The subject of this paper "Application of Photoshop in digital photography" examines the 

application of Photoshop in a creative and technical development of digital photographic image. 

Photo processing is a relatively broad term covering any kind of change in the original photo, 

from minimal changes (retouch, edit or color correction, copying and cutting out certain parts 

of the photograph), to making an entirely different and new photos from combining several 

images or segments. To make such adjustments it is necessary to clarify what is Photoshop and 

what are its opportunities and the tools needed to produce these images. Also, if Photoshop and 

digital photography will be mentioned, then some details about digital photography will be 

given souch as; what is digital photography, its brief history and also the advantages and 

disadvantages between classic and digital photography. 

KEY WORDS: Photoshop, digital photography, photo processing 
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1. UVOD 

Tema ovog završnog rada jest primjena grafičkog programa Adobe Photoshop u digitalnoj 

fotografiji. U ovome radu će biti detaljno objašnjeno korištenje spomenutog grafičkog 

programa, njegove mogućnosti u obradi digitalne fotografije i detaljan opis same digitalne 

fotografije.   

Za početak, što je zapravo fotografija. Fotografija je tehinka digitalnog ili kemijskog 

zapisivanja prizora iz stvarnosti na sloju materijala koji je osjetljiv na svjetlost. Riječ dolazi od 

grčke riječi phos (“svjetlo”), te graph (“crta”), koje skupa znače “crtanje pomoću svjetla”. Kao 

domaća riječ za fotografiju koristi se riječ svjetlopis. Fotografija je, drugim riječima, tehnika 

zabilježavanja stvari, događaja i likovnih elemenata uz pomoću svjetlosti i leće. Može se 

definirati kao vizualnu umjetnost koja spada pod granu likovnih umjetnosti gdje fotograf 

pomoću fotografskog aparata zaustavlja trenutak realnog života. Postoji više grana fotografije 

kao npr. umjetnička fotografija, dokumentarna fotografija, portretna fotografija, reklamna 

fotografija itd. Što se tiče umjetničke fotografije, ne zaustavlja bilo koji trenutak, nego upravo 

onaj odlučujući u kojem neka radnja otkriva svoj dublji smisao.  

Fotografija može biti amaterska ili profesionalna. Sama kvaliteta fotografije ne treba biti 

striktno vezana uz profesionalno fotografiranje, već ovisi o znanju, originalnosti, maštovitosti 

i vještini samog fotografa. Naime, fotografija ne može nastati bez fotoaparata. Zato je u ovom 

završnom radu naglasak na digitalnom fotoaparatu tj. digitalnoj fotografiji.  

Digitalnu fotografiju možemo opisati kao digitalni zapis na digitalnoj površini. To bi značilo 

da je digitalna fotografija binarni zapis odnosno skup 0 i 1 zapisanih na memoriju. Što bi značilo 

da nam je za ovakvu fotografiju potreban uređaj koji u sebi ima procesor i memoriju tj. digitalni 

fotografski..  

Primjena Photoshopa u digitalnoj fotografiji je među najnormalnijim stvarima današnjice. 

Koristi se za transformiranje originalne fotografije u nama željenu sliku. Naime, Photoshop je  

grafički računalni program, razvijen i izdan od strane američke tvrtke Adobe Systems. Također 

je i najpoznatiji računalni program za obradu slike, koju možemo podijeliti u dvije vrste: 

- Kreativna obrada digitalne slike 

Takva fotografija može biti sastavljena od više različitih slika tj. obuhvaća značajniju promjenu 

fotografije. Ovakva vrsta obrade fotografije se počela koristiti zbog nemogućnosti 

fotografiranja iste u npr. studiju ili nekakvoj lokaciji.  Fotografija je vizualno uočljivija ili 

atraktivnija te se danas najčešće koristi u reklamne ili promotivne svrhe. 

 

Slika 1. Kreativna obrada digitalne slike 
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- Tehnička obrada digitalne slike 

Namijenjena je za tehničko poboljšanje fotografije. Koristi se za npr. Uklanjanje određenih 

motiva sa fotografije, uklanjanje bilo kakvih nedostataka, retuširanje, prilagođavanje oštrine, 

uklanjanje vidljivih mana na koži ili materijalu itd. 

 

 

Slika 2. Tehnička obrada digitalne slike 

 

Dakle, Obradom fotografija se nastoji poboljšati fotografiju ili od više različitih fotografija 

načiniti potpuno novu. Takve obrade su prijekopotrebne da bi se dobio rezultat koji je potreban, 

a koji je nemoguće dobiti ili izmjeniti prilikom fotografiranja određenog motiva.  Ona se 

koristila i koristi se u politici, novinarstvu, glamurnoj fotografiji (za retuširanje lica i tijela 

poznatih ličnosti) i najviše u marketingu trgovina. U politici se obrada fotografija od početka 

koristila kako bi gledatelje prevarila ili nagovorila na nešto, odnosno u svrhu poboljšanja 

pripovijedanja ili samoizražavanja. Npr. Joseph Stalin je iskoristio foto retuširanje u 

propagandne svrhe. Što se tiče obrade fotografije u novinarstvu, jedan kontroverzno značajan 

slučaj je bio 1892. u časopisu National Geographic. Naime, urednici časopisa su preselili dvije 

egipatske piramide bliže kako bi mogla stati na vertikalnoj stranici. Taj slučaj je pokrenuo 

debatu o prikladnosti retuširanja u novinarstvu. Što se tiče upotrebe Photoshopa u marketingu 

trgovina ili reklamnoj fotografiji, ona je najizraženija i koristi se svakodnevno.   Ovisno o 

primjeni fotografije, može se reći da se njome može dočarati ugođaj, uvjeravati ili objašnjavati.  
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2. TEORIJSKI DIO 

 

2.1.Digitalna fotografija 

Za razliku od klasične, ne koristi film već sliku "vidi" preko elektroničkog senzora kao skup 

binarnih podataka. 

Digitalna fotografija je oblik fotografije koji upotrebljava niz svjetlosno osjetljivih senzora za 

snimanje slika, na koju je usredotočen objektiv. Snimljene slike se zatim pohranjuju kao 

digitalne datoteke spremne za digitalnu obradu (veličina slike, obrezivanje, retuširanje, 

podešavanje kontrasta boja itd.), pregled ili ispis slike. Prije nego što je takva tehnologija 

nastala, fotografije su bile izrađivane uz izlaganje svjetlo-osjetljivog fotografskog filma i 

razvijene pomoću kemijskog procesa. Kod digitalne fotografije slika se stabilizira uz pomoć 

matematičkih operacija pomoću algoritama koje obavljaju elektroničke komponente. Kod oba 

slučaja slika nastaje pomoću fotoelektričnog efekta, u fazi nastanka slike razlikuju se u tome 

što je kod klasične fotografije efekt ireverzibilan dok je kod digitalne reverzibilan, tj. taj isti 

osjetljivi medij se može koristiti više puta.  

Prednost digitalne fotografije je naknadni prikaz slike, uređivanje, ispisivanje, transformiranje 

i pohranjivanje pomoću različitih digitalnih i računalnih uređaja bez kemijskih postupaka.  

 

 

2.1.1. Povijest digitalne fotografije 

Krenuvši od same povijesti prvu fotografiju prirode načinio je francuz Nicephore Niepce 1826-

e godine uz pomoć svjetlosti i kamere opskure. Upotrijebio je metalnu ploču premazanu 

otopinom bitumena (asfalta) i izložio u kameri opskuri. Ekspozicija je trajala 8 sati. Nipce-ov 

postupak usavršio je francuski slikar panorama i kazališne scenografije Luj Mande Daguerre. 

Luj je sa Nipce-om prethodno sklopio ugovor o usavršavanju unesevši u proces soli srebra i 

dobio prve fotografije na posrebrenoj ploči 1837. godine. Daguerre je posrebrenu ploču izlagao 

jodnoj pari, a nevidljivu sliku učinio vidljivom tako što ju je razvijao (izazvao) u pari žive i 

fiksirao u otopini natrij sulfita (tj. Kuhinjske soli).  Daguerre-ovo usavršeno otkriće je službeno 

objavljeno 1839. godine pred francuskom Akademijom i poklonjeno svijetu. Taj dan smatra se 

rođendanom fotografije.  Unikati “Dagerotipije” su se mogle promatrati samo pod određenim 

kutom. Englez William Henry Fox Talbot je neovisno započeo svoju metodu dobivanja 

negativa 1835. godine kada je dobio prve fotografske minijature na papiru. Talbot je u kameru 

opskuri unosio papir prepariran srebrnim kloridom i tako dobijao negativ, od kojeg se 

kopiranjem mogao dobiti neograničen broj pozitiva. Iznio je svoje otkriće u Londonu, nekoliko 

mjeseci poslije Duggera. Od samog početka teoretičari su sumnjali u umjetničke fotografije 

nastale kamerom opskure4 te su tvrdili da je fotografija samo preslika ili odraz prirode postignut 

mehaničkim sredstvom. No, danas je i više nego jasno da je fotografija ograničena na 

prikazivanje predmeta iz realnog svijeta, ali fotograf ima široke mogućnosti da izrazi svoj 

osoban pogled na taj isti svijet. 
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Prvi zaslužni za digitalnu foto-revoluciju su George Smith i Willard Boyle, koji su 1969. godine 

otkrili charge-coupled uređaj (CCD), osnovni čip digitalnih fotoaparata. CCD je prvi puta 

ugrađen u fotoaparat 1970. godine, a nakon 5 godina kasnije počinje stvarati sliku koja se može 

prikazati na tv-u u zadovoljavajućoj rezoluciji. 

Godine 1981. prvi puta je predstavljeni fotografski aparat koji MAVICA, koji kao fotoosjetljivi 

medij koristi senzor.. Mavica je proizvod Sony-a i ime je dobila po svojoj tehničkoj razvijenosti 

(mavica = Magnetic Video Camera). Ovaj fotografski aparat je magnetske impulse snimala na 

maloj disketi, uz pomoć dva CCD čipa. Prvi zapisuje informacije o svjetlosti, a drugi 

informacije o bojama. Mavica je više ličila na kutiju za diskete, nego na fotoaparat te se nije 

mogla svrstati među prave digitalne fotografske aparate. 

Razvoj profesionalne digitalne fotografije se može pratiti od 1990. i 1991. godine. Canon 1D 

prvi je pravi profesionalni digitalni fotografski aparat koji se na tržištu pojavio 2001. godine. 

Program za digitalnu obradu fotografija počeo se razvijati od 1990. Danas se koristi kao 

najmoderniji alat za obradu digitalnih fotografija te se naziva Photoshop.  

 

  

                                                           Slika 3. Fotografski aparat MAVICA 

 

2.1.2. Vrste digitalnih fotografskih aparata 

Pod osnovnom podjelom bi se mogla svrstati amaterska i profesionalna oprema, a tzv. 

prijelaznu kategoriju čine poluprofesionalni ili napredni amaterski fotografski aparati.  

Amaterska oprema nema previše mogućnosti za podešavanje i potpuno je automatizirana. 

Često se svodi samo na pritisak okidača i zamjenu baterija. To su fotografski aparati koji će 

dati vrlo kvalitetne slike, a i dobro će izgledati na ekranu računala. No, slabija kvaliteta 

objektiva će pri lošim svjetlosnim uvjetima rezultirati mutnim snimcima. Zbog takvih uvjeta se 

često koriste visoke osjetljivosti filma, što će pak rezultirati zrnatošću slike. Često dolazi i do 

dužih ekspozicija zbog ne tako dobre svjetlosne jakosti objektiva, te se dodatno razmazuje 

oštrina zbog nehotičnog pomicanja fotografskog aparata. Neki od mnogih sitnih nedostataka 

amaterske opreme su još i naginjanje boja prema plavim tonovima i ograničene mogućnosti za 

korekcije u nesvakidašnjim uvjetima (jake sjene, protusvjetlo, manipuliranje s parametrima 

zbog posebnih efekata itd.).  
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Profesionalna oprema ima također potpunu automatiku, ali za razliku od amaterske sadrži 

mogućnost ručne postave, zadavanje pojedinih elemenata kao što su osjetljivost filma i veličina 

otvora objektiva, nudeći velik broj posebnih opcija: veću snagu i posebne režime bljeskalice, 

mjerni predbljesak u cilju izračunavanja ispravne ekspozicije, vrhunske sustave mjerenja 

svjetline slike u više točaka, makrosnimanje sitnih objekata sa svega nekoliko cm udaljenosti, 

snimanje ugrađenim “nevidljivim” svjetlom u potpunom mraku, veće raspone teleskopiranja, 

snimanje panoramskih snimaka, snimanje tzv. “tepiha”, tj. istog motiva s tri različite 

ekspozicije od kojih se izabire ona najbolja, veći izbor kvaliteta razlučivanja uključivo snimanje 

u TIFF formatu, automatsko uzastopno snimanje 1-3 slike u sekundi i dr.  

Tako bi izgledala osnovna podjela što se tiče digitalne opreme fotografskog aparata, a nešto 

detaljnija podjela bi izgledala ovako: 

 

 

 

1. KOMPAKTNI FOTOGRAFSKI APARATI (amaterski kompaktni i poluprofesionalni 

kompaktni aparati) - aparati koji imaju nezamjenjivi objektiv. To su aparati manje težine 

te su najlakši za rukovanje i fokusiranje. Objektiv se može uvlačiti kada nije u uporabi, 

no nije obavezno. Ova vrsta fotografskih aparata je namijenjena za svakodnevnu 

uporabu i zgodni su za prenošenje. Što se tiče optike, nije na zavidnom nivou ali se 

pomoću takvih fotoaparata mogu snimiti dosta kvalitetne fotografije. Također imaju 

ugrađenu bljeskalicu, a fotografije snimaju u JPEG formatu. 

 

 

  

Slika 5. Kompaktni fotografski aparat 
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2. ULTRAKOMPAKTNI FOTOGRAFSKI APARATI (amaterski ultrakompaktni i 

poluprofesionalni ultrakompaktni fotografski aparati) - fotografski aparati sa 

neizmjenjivim objektivom koji se također uvlači u tijelo i ne strši. Ovakva vrsta 

fotoaparata je malih dimenzija i težine ispod 200 gr. Ultrakompaktni fotografski aparati 

su prijelazna varijanta do profesionalnog aparata i izgledom liče na profesionalne, a 

kvaliteta fotografija i snimaka je daleko bolja od kompaktnih, što obično prati i vrlo 

visoka cijena. Snimaju fotografije u JPEG ili RAW formatu te imaju dosta razvijen 

optički zoom i pogodniji su za pregled fotografija.  

 

 

 

Slika 6. Ultrakompaktni fotografski aparat 

 

3. SLR - zrcalo-refleksni fotografski aparati (kompaktni i profesionalni SLR aparati). 

Kratica SLR se odnosi na sustav tražila, tj. označava fotografske aparate sa jednim 

sustavom leća za tražilo i stvaranje slike. Refleksni fotografski aparati najčešće imaju 

izmjenjivi objektiv, s mogućnostima poluprofesionalnog ili profesionalnog 

fotografskog aparata. Prednost SLR-a je unaprijed moguća provjera dubinska oštrina 

budućeg snimka. Snimaju fotografije vrlo visoke kvalitete i jasno dočaravaju dubinu 

fotografije. Često, SLR fotografski aparati koriste zoom objektive i mnoge opcije za 

ručno podešavanje parametara za snimanje fotografija. Fotografski aparati su glomazni 

i teški te nisu namjenjeni “turističkom” snimanju, već profesionalnom fotografiranju, a 

često se ugrađuju i mehanički ili elektronički uređaji za stabilnost aparata protiv 

neželjenog pomicanja za vrijeme ekspozicije.  

 

 

Većina fotografskih aparata ima mogućnost podešavanja sljedećih vrijednosti: 

• izoštravanje (kojim se izoštrava projekcija motiva što je na nekoj udaljenosti od objektiva), 

• otvor objektiva (otvorenost objektiva, što je veći otvor blende na fotoosjetljivi sloj pada više 

svjetla)  

• vrijeme eksponiranja (trajanje propuštanja svjetla kroz objektiv, što je dulja ekspozicija na 

film pada više svjetla). 
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2.1.3. Prednosti i mane digitalne fotografije u odnosu na klasičnu 

 

U današnjem svijetu visoko razvijene tehnologije, gdje većina fotografa koristi digitalne 

fotoaparate, raste broj zainteresiranih za klasičnu fotografiju. Iako za normalnog koji posjeduje 

bilo kakvo računalo, prednosti digitalnih fotoaparata obično su brojnije nego njihove lošije 

strane. No, sve je više profesionalnih fotografa koji imaju podijeljena mišljenja. Kako bi se 

bolje opisale i razumijele prednosti i mane digitalne fotografije u odnosu na klasičnu, 

uspoređeni su različiti aspekti jedne i druge vrste fotografije: 

 

Vrijeme eksponiranja 

U uvjetima gdje je osvjetljenje slabo, u velikoj prednosti su digitalni fotoaparati. Osjetljivosti 

filma u klasičnoj fotografiji može se kretati u rasponu od ISO 100 do ISO 3200, iako postoji i 

film osjetljivosti ISO 6400. Što se tiče digitalne fotografije, često su mnogo osjetljiviji te mogu 

simulirati osjetljivost od ISO 51200, dok profesionalni fotoaparati mogu snimati i do ISO 

409,600. Druga prednost digitalnih fotoaparata je u tome da mogu mijenjati ISO na svakoj 

fotografiji, dok je kod klasičnih filmova koji se danas koriste, ISO jednak u svakoj roli. Iako 

film kod klasične fotografije može podnesti velike promjene u stopama svjetla, to utječe na 

količinu kontrasta na fotografiji.  

 

Rezolucija 

Označava broj piksela na jedinici površine. rezolucija označava kvalitetu digitalne snimke, bez 

obzira radi li se o rezoluciji ispisa, snimljenoj rezoluciji ili onoj koju vidimo na ekranu. 

Što se tiče rezolucije, svaki fotograf bilo da se bavi klasičnom ili digitalnom fotografijom, ima 

želju da njegove fotografije rezultiraju visokim rezolucijama. Kod filma se sposobnost 

razlučivanja mjeri uz pomoć kutne razlučivosti, dok se s druge strane kod digitalnih senzora 

rezolucija određuje zbrajanjem piksela na zadanoj površini. Kao što različite vrste filma 

proizvode različitu rezoluciju, tako i različiti digitalni senzori proizvode različitu rezoluciju.  

 

Dinamički raspon 

Raspon preciznosti nivoa sivog ili nivoa boje na snimci od najviše do najniže razine. Što više 

podataka dinamičkog raspona fotoaparat može registrirati više će finijih gradacija biti sačuvano 

u konačnoj snimci. 

Kod dinamičkog raspona, digitalni fotoaparati imaju prednost nad analognim. Većina analognih 

fotoaparata ima oko 13 stopa dinamičkog raspona dok današnji digitalni fotoaparati imaju i do 

15 stopa. Film pruža izniman dinamički raspon, ali današnja digitalna tehnologija je jednako 

dobra.  
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Digitalni šum/zrnatost filma 

Nasumično pojavljivanje malih točkica na fotografiji. 

Kod digitalnih fotoaparata, šum je rezultat neželjenih elektroničkih signala koji su nastali u 

elektronici fotoaparata. Kod filma, uzrok su male kemijske čestice koje nisu primile dovoljno 

svjetla. Fotografije će biti podložnije šumu i zrnatosti prilikom povećanja ISO vrijednosti 

digitalnog fotoaparata ili odabirom filma više osjetljivosti kod analognog. Digitalna fotografija 

je do danas evoluirala do točke kod koje ima mnogo manje šuma nego njezin analogni 

ekvivalent. Kako bi općenito izbjegli šum, digitalni senzori moraju raditi pri niskim 

temperaturama, dok film nema problema sa pregrijavanjem. 

Još neke prednosti i mane digitalne u odnosu na klasičnu fotografiju 

 

Prednosti 

● Ne kupuju se filmovi 

● Ne treba razvijati snimljeni materijal  

● Nema opasnosti da se slika “izgrebe”  

● Postoje brojne opcije koje klasični fotoaparati nemaju  

● Broj slika koje možemo pohraniti na memorijsku karticu je znatno veći od broja koji 

stane na jedan film 

● Digitalnu fotografiju možemo montirati, retuširati i obrađivati pomoću određenog 

grafičkog programa (npr. Photoshop) 

 

Mane 

● Digitalni fotoaparati jako troše bateriju, pa je potrebno često puniti ili kupovati novu 

● Skuplji su u odnosu na klasične 

● Digitalne slike se mogu izgubiti u slučaju kvara hard diska, dok su slike na filmu 

pouzdane za dokumentaciju 

● Ne postoji softver koji može otkriti što je promijenjeno na digitalnoj slici, dok se na 

filmu lako mogu uočiti sve naknadne promjene 

● Digitalne fotografije su često izložene virusima, zbog loših medija koji ih čuvaju (usb, 

cd, dvd) 
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2.2.Photoshop 

 

2.2.1. Što je Photoshop i koja je njegova uloga? 

Adobe Photoshop, ili skraćeno Photoshop, je najpoznatiji računalni program za obradu 

slike, uređivanje fotografija, stvaranje slika i program namijenjen grafičkom dizajnu. Razvijen 

je i izdan od američke tvrtke pod nazivom Adobe Systems tj. Adobe-ovog kreativnog tima za 

Windows i Macintosh platformu. Photoshop je namijenjen za grafičku obradu i prezentaciju 

slike u 2D ili 3D formatu. Jedna od prednosti je ta što može urediti i sastaviti rasterske slike u 

više slojeva te sadrži nekoliko modela boja, uključujući RGB, CMYK, lab, grayscale, binary 

bitmap i duotone.  Jedan od razloga zašto je Photoshop toliko popularan što je njegovo sučelje 

prilagodljivo, veoma je intuitivan te raspolaže sa većim brojem alata koji su vrlo jednostavni za 

korištenje. Photoshop sadrži preko 60 alata  za obradu crteža, slika, fotografija, dodavanja 

posebnih efekata na slike itd. Gotovo sve fotografije sa kojima se susrećemo su obrađene, 

proljepšane ili potpuno izmjenjene pomoću spomenutog grafičkog programa.  

 

2.2.2. Povijest Photoshopa 

              Photoshop je kreiran od strane braće Amerikanaca Thomas-a i John-a Knoll-a 1987. 

godine. Braća su distribucijsku licencu prodala Adobe systemsu 1988. godine. Thomas Knoll, 

student dr. sc. na sveučilištu u Michiganu, počeo je pisati program za prikaz slike u sivim 

tonovima na crno-bijelom zaslonu. Ovaj program, pod nazivom Display, je privukao pažnju 

njegovog brata Johna Knolla, koji je preporučio Thomasu da ga pretvori u program za potpuno 

editiranje slika. Thomas je u 1988. godini uzeo šest mjeseci pauze od svog studija  da surađuje 

s bratom na programu, kojeg je naknadno preimenovao u ImagePro, no ime je već i bilo zauzeto. 

Kasnije te godine, Thomas je preimenovao svoj program u Photoshop.  

Za to vrijeme, John je otputovao u Silicijsku Dolinu i prezentirao program inženjerima Apple-

a  i Russell Brownu, art direktoru u Adobe-u. Obje projekcije su bile uspješne i Adobe je odlučio 

kupiti licencu za distribuciju u rujnu 1988. godine. Dok je John radio na plug-insima u 

Kaliforniji, Thomas je ostao u Ann Arboru pisati kod programa. Photoshop 1.0 je prva inačica 

ovog programa te je objavljena u veljači 1990. godine isključivo za Macintosh upravo sa željom 

simulacije rada u fotografskom laboratoriju te je postao standard profesionalne izrade u 

digitalnoj fotografiji. Posljednja je trinaesta generacija, pod nazivom Photoshop CS6. 
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2.2.3. Programski alati i parametri kod Photoshopa 

Photoshop nudi preko 60 alata za obradu slike, unos teksta, crtanje, selektiranje, kopiranje i 

slično. Također sadrži na desetke zasebnih unosa parametara za svjetlinu, kontrast, definiranje 

boje itd. Objasniti će se neki od najzanimljivijih i najkorištenijih alata prilikom obrade 

fotografije. Photoshopovo sučelje je podijeljeno u par osnovnih grupa: 

 

ALATNA TRAKA 

Ovdje se nalaze razni alati za modificiranje, izradu objekata i pomicanje. Jedni od značajnijih 

su: 

 

Move Tool (shortcut V) 

 Ovim alatom se  pomiču selektirani objekti u aktivnom layeru, a ako ništa nije 

selektirano pomiče se cijeli aktivni layer. 

 

Rrectangular Marquee Tool (shorcut M)  

 Prvi alat na paleti je RM Tool, aliće se nazvati alat za pravokutne selekcije. Alat za 

selekciju omogućava selektiranje, tj. označavanje željene pixele. 

Elliptical Marquee Tool - alat za kreiranje okruglih i elipsastih selekcija 

Single Row Marquee Tool - alat za kreiranje selekcija od samo 1 piksel vodoravno. 

Single Column Marquee Tool - alat za kreiranje selekcija od samo 1 piksel okomito.   

 

 
 

 

 

Lasso Tool (shorcut L) 

 Koristi se za pravljenje selekcije „slobodnijom rukom“. Manje više prati pokret miša i 

radi selekciju.  

Polygonal Lasso Tool- alat za kreiranje selekcije klikanjem mišem pomoću kratkih 

linija. 

Magnetic Lasso Tool- kreiranje selekcije na slikama koje nemaju puno nijanse palete 

boja i puno krivih rubova.  
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Magic Wand Tool (Shortcut W) 

 Odabirom ovog alata i klika na neku boju, na slici će se selektirati dotična boja na 

cijelom layeru. 

 

Quick Selection Tool 

 Služi za slikanje selekcije kao kistom. Selekcija se zatim širi do neke granice, npr. 

promjene u boji ili svjetlini pixela. 

 

Slice Tool (shortcut K) 

 Razvlačenjem okvira sa ovim alatom dijeliti će se slika na pravokutna polja koja se mogu 

zasebno spremati. Krajnji efekt je nešto poput slagalice. Sekundarni alat, Slice Select, 

omogućava unošenje nekih parametara za određeni dio slike. 

 
 

Crop Tool (shortcut C) 

 je alat kojim će se u slici ostaviti samo željeni objekt i tako ga bolje kadrirati. 

Razvlačenjem pravokutne selekcije izabire se dio slike koji se želi ostaviti, a ostalo će biti 

izbrisano. Također sada će se slika smanjiti samo na taj selektirani dio. 

 

 

Brush Tool (shortcut B) 

 Služi za slikanje boja na aktivnome layeru. Moguće je mijenjati svojstva npr. debljinu i 

prozirnost. Ostali alati su Pencil koji nude oštre linije i više su namjenjene ilustracijama, dok 

je Brush više namijenjen za slikanje. 

 
 

Healing Brush Tool (shortcut J) 

 Alat za kopiranje određenog dijela slike. Držeći Alt prvo se selektira jedan dio slike, a 

zatim se preboji na željeni dio slike, npr. selektira se dio normalne boje auta i preboji preko 

hrđe.  Zatim ima Patch alat kojim se može prekriti neki dio slike ne samo selekcijom već i 

nekim uzorkom. Zadnji alat je Color Replacement Tool koji omogućuje promjenu boje na slici 

ili objektu. 
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Clone Stamp Tool (shorcut  S) 

Služi za preslikavanje jednog dijela slike na drugi. Drugi alat Pattern Stamp Tool je 

sličan prethodnom alatu samo što ostavlja Pattern postavku.  

 
 

Gradient (shortcut G) 

Alat za pretapanje jedne boje u dvije ili više njih. Pretapanje se vrši u smjeru linije koja 

se razvuče mišem. Alternativni alat je Paint Bucket, koji u određeno polje izlije selektiranu 

boju i razlije se do određenih granica. 

 
 

 

 

Smudge Tool (Shorcut R) 

 Njime se razmazuje boja boju. Služi za stvaranje prijelaza između dvije boje. Blur i 

Sharpen su alternativni alati pomoću kojih se zamućuje odnosno izoštravaju selektirani dijelovi 

slike. 

 

 
 

Dodge tool (shortcut O) 

Služi za izbjeljivanje određenog područja na fotografiji ili slici. Npr. Posvjetli se boja 

nečijih traperica kao da su više puta oprane. Burn Tool služi za potamnjivanje tonova, također 

sa mogućnosti da očuva određeni ton kod potamnjivanja objekata u određenoj boji, dok treći 

alat pod nazivom Sponge Tool ima opcije Saturate i Desaturate. Dodavanje boja i oduzimanje 

boja tj. Put ka crno-bijeloj slici.  

 
 

 

 

 

 

 

 



13 
 

Path Selection Tool (Shortcut A) 

 Oba alata služe sa selekciju. Razlika je u tome što Path Selection Tool služi za selekciju 

cijelog patha kao jedne cijeline, dok se Direct Selection Tool koristi za odabir pojedinog dijela 

selekcije. 

 
 

 

 

Horizontal Type Tool (Shortcut T) 

 Alat za upisivanje teksta kod kojeg se mijenja veličina, font, boja itd. Alternativni alati 

kao što su Vertical Type Tool, Horizontal Mask i Vertical Mask piše se u raznim smjerovima 

i u obliku selekcije. 

 
 

 

 

Pen Tool (shortcut P) 

 Ovaj alat omogućuje precizno iscrtavanje objekata, koji se zatim selektiraju po iscrtanoj 

Bezierovoj krivulji i kao takvi izrezuju iz originala. 

 

 

 

Rectangle Tool (Shortcut U) 

 Ova grupa od 6 alata sadrži Rectangle (Kvadrat), Rounded Rectangle (Zaobljeni 

kvadrat), Elipse (Elipsa), Polygon (Višekutnik), Line (Linija, crta) i Custom Shape (Vlastiti 

oblik) Tool. Sa svakim od alata crtaju se istoimeni oblici. 
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Eyedropper Tool (Shortcut I) 

 Jedan od najvažnijih alata kojim se selektira određena boja iz slike na kojoj se radi. Pod 

alternativnim alatima se može naći Measure Tool kojim se mjeri dužina od neke A do B točke. 

Color Sampler Tool je napredniji alat kojim se nadzire vrijednost boja od 4 statične točke na 

slici. 

 
 

Color Select Box 

  Koristi se za biranje glavne (aktivne) boje i boje pozadine. 

 

I ostali kao što su: History Brush Tool, Eraser tool, Notes Tool, Hand Tool, Zoom Tool itd. 

 

 

DODATNE OPCIJE IZABRANOG ALATA 

 

Nakon što se izabere alat, ovdje se može namjestiti njegove parametre, npr. debljina i snaga 

kista, vidljivost, dimenzije okvira za selekciju. 

 

 

NAVIGATOR 

 

Smanjeni prikaz radne plohe koji u slučaju da se radi na zumiranoj fotografiji, 

crvenim kvadratom pokazuje gdje se nalazi na slici. 

 

 

LAYER EDITOR 

 

Svi layeri (slojevi) su ispisani ovdje i tu se mogu spajati i modificirati. 

 

 

GLAVNI IZBORNIK 

 

Standardni File, Edit i ostali izbornici u kojima se otvaraju i spremaju radovi, ali tu ima još 

mnogo izbornika sa opcijama promijene slike ali i izgleda Photoshopovog sučelja. 
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OSNOVNE OPCIJE SLIKE 

 

Desnim klikom na naslovnu traku slike na kojoj se  trenutno radi, otvara se mali izbornik sa 

najosnovnijim opcijama poput dimenzija stranica slike, dupliciranja slike, informacija o slici 

itd. 

 

Photoshop sadrži jos mnogo alata za obradu fotografske slike no još neke najosnovnije koje se 

koriste su kao npr. curves (zadaća im je izmjena u udjelu tamnih, svijetlih i srednjih tonova na 

fotografiji), brightness/contrast (omogućuje izmene u kontrastu i svjetlini fotografije) te 

Hue/Saturation (saturacija i nijanse) i Color Balance (balans boja). 

 

 

 

2.2.4. Mogućnosti Photoshopa kod obrade digitalne slike 

Kada se priča o obradi digitalne fotografije, tada se smatra da je to naknadna manipulacija 

fotografije u vektorskim i grafičkim softverima koji služe kao alat za mijenjanje, štimanje, 

poboljšavanje slike, primjerice poput Photoshopa. Mnogi fotografi su ograđeni od činjenice da 

je digitalnoj fotografiji potrebna bilo kakva naknadna obrada u grafičkom programu, odnosno 

na računalu. Obrada digitalne fotografije se može raditi na mnogo načina, a svi se razlikuju 

prema kvaliteti koja se želi postići. Takvi načini obrade omogućili su “kućnu” kontrolu 

prezentacije ili ispisa slike. Najčešće se tim obradama  popravljaju samo nedostaci koji se nisu 

mogli popraviti tijekom snimanja fotografije te se ne mijenja bit fotografije niti njezina priča. 

Takva vrsta obrade, kao i ranije navedeno, naziva se tehnička izrada digitalnog zapisa 

fotografske slike.  Suprotno tome, mijenjanje srži fotografije dodatnim montažama, kako bi se 

iskrivila ili promjenila priča fotografije, naziva se kreativna obrada digitalne fotografije.  U 

nastavku su prikazani primjeri mogućnosti Photoshopa u obradi fotografije nastale digitalnim 

putem.  

 

 Izdvajanje dijela fotografije (Slika 10. i 11.) - pomoću Photoshopa je moguće 

doslovno izrezati dio neke slike koji će kasnije i sam postati nezavisna slika. 

Pomoću ovakve tehnike se poboljšava kompozicija slike. 

 

Slika 10. Originalna fotografija 
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Slika 11. Izdvojeni dio fotografije 

 

 Histogram - slikovni histogram koji prikazuje vrijednost osvjetljenja 

pojedinog piksela.  

 

 Otklanjanje nečistoća - u nekoj mjeri su u mogućnosti otkloniti smetnje sa 

neke slike. Najčešće su takve slike popunjene takozvanim točkicama (noise) 

koje su rezultat slikanja u slabom osvjetljenju. 

 

 Uklanjanje neželjenih dijelova (Slika 12. i 13.) - uklanjaju se dijelovi ili 

segmenti fotografije po želji samog fotografa. 

 

 

Slika 12. Originalna fotografija 

 

Slika 13. Slika sa uklonjenim djelom 
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 Položaj slike - slika se može okretati u bilo kojem uglu i položaju. Moguće je 

mijenjati perspektivu, zakrivljavati ih, prevrtati i preslikavati. 

 

 Spajanje dvije ili više slika ili dijelova slika u jednu cjelinu. 

 

 

 Specijalni efekti- program može primjeniti umjetničke, geometrijske, teksturne i 

mnoge druge efekte. 

 

Jedne od mnogih drugih mogućnosti Photoshopa u obradi digitalne fotografije je mijenjanje 

dubine boje, kontrast i svjetlina, izoštravanje i glađenje, štimanje boja, uklanjanje nečistoća itd.  
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3. PRAKTIČNI DIO 

 

3.1.Postupak tehničke obrade digitalne slike 

(Korištene su autorske fotografije) 

Tehnička obrada digitalne slike obuhvaća obradu i poboljšanja na jednoj fotografiji. Neke od 

čestih obrada odnose se na izmjenu i poboljšanje kontrasta i svjetline, uklanjanje šuma, zatim 

korekcija boja, zrnatost koja se često pojavljuje na fotografijama, uklanjanje sitnica koje 

fotograf ne želi na slici, ispravke “crvenih očiju” itd. U nastavku će biti prikazane i objašnjene 

neke faze prilikom jednostavnije obrade fotografije. 

 

Fotoaparat: Canon 30D 

Objektiv: 17-85 mm 

Vrijeme ekspozicije: 1/600 

             F: 5.6 

             ISO:100 

 

  

Slika 14. Originalna fotografija 

Fotografija na kojoj će se raditi obrada, već je dosta korektna sama po sebi. U nastavku će biti 

prikazano kako se određenim načinima fotografiju može učiniti vizualno interesantnijom i 

promijeniti estetiku same fotografije. 
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Povećanje tamnih ili svijetlih tonova 

U ovome primjeru će se povećati zasićenje tamnih tonova. Takvu promjenu nam omogućuje 

izmjena parametara Curves postavki na način da se u donjem lijevom uglu krivulje napravi 

točka koja će se povući prema dolje proizvoljno, te će se na taj način povećati udio tamnih 

tonova na fotografiji. na taj način će se slika potamniti, najviše kod originalno tamnih tonova. 

 

 

 

 

 

Slika 15. Povećanje tamnih tonova 
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Izoštravanje detalja na fotografiji 

Izoštravanje željenih dijelova fotografije se može izraditi na više načina, čak i Sharpen alatom, 

no u ovakvim slučajevima trebao bi se koristiti kvalitetniji način izoštravanja. Postupak je takav 

da se postojeći layer(sloj) duplicira te se na njega primjenjuje Filter pod nazivom High Pass. 

Podešavanje je takvo da kada se otvori prozor sa parametrima Filtera, fotograf ili autor 

fotografije sam odlučuje kolika će biti oštrina elemenata. U ovom slučaju cilj je zaoštriti crtež 

na fotografiji. 

  

Nakon što se High Pass aktivirao na dupliciranom Layeru, kod opcija za Layer-e svojstvo 

dupliciranog layer-a postavlja se na Overlay. Pošto je efekt High Pass-a apliciran na 

spomenutom layer-u, duplikat i original se spaja u jedan layer selektiranjem oba i pomoću tipki 

Ctrl+E. 

 

 

Slika 16. Izoštravanje detalja 
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Zamućivanje pozadine 

Iako na ovoj fotografiji nije potrebno dodatno zamućivanje, biti će spomenuto tek toliko da se 

sazna princip zamućivanja. U ovom slučaju se zamućivanje može izvršiti Blur alatom sa 

jačinom namještenom po želji, a zatim se Brush-em prelazi preko dijelova koji se žele zamutiti, 

u ovom slučaju pozadina, kako bi se dodatno istaknuo glavni motiv na slici. 

Nakon zamućivanja pozadine može se još više istaknuti glavni motiv na fotografiji. kako bi se 

još više  smanjila pozornost na pozadinu, potrebno ju je zatamniti onoliko  da motiv bude u 

fokusu i da dođe još više do izražaja. Zatamnjenje se vrši pomoću Burn alata, a jačina 

zatamnjivanja  je također proizvoljna. 

 

 

Slika 17. Zamućena i zatamnjena pozadina 

 

 

Do sada su bile spomenute neke od glavnih i jednostavnijih obrada digitalne fotografije. U 

sljedećem koraku se fotografije može vizualno više promijeniti, a to će se promijeniti 

dobivanjem ton određene boje preko cijele slike.  
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Izmjena balansa boja 

Izmjeniti će se boja na način da se otvori prozor sa Color Balance postavkama. Pomicati će se 

vrijednosti za cyan, magentu i žutu, odnosno crvenu zelenu i plavu te se dobivaju određene 

promjene boje na fotografiji. Nakon unosa novih parametara, razlika u boji je više nego očita. 

 

 

 

Slika 17. Izmjenjen balans boja 
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Slika 18. usporedba fotografije prije i nakon obrade 

 

Može se primjetiti da je fotografija vidljivo izmjenjena od originala, te nije više potrebno dalje 

raditi na njoj. Daljnje promjene ovise o samom autoru fotografije i što zapravo želi postići.  

Naime ako nam nije potrebna boja na slici vrlo lako ju jednim klikom miša pretvorimo u crno 

bijelu fotografiju. Izmjeniti će se boja na način da se otvori prozor sa Desaturate postavkama 

(pod Image>Adjustments>Desaturate). Ništa se tu posebno ne mora podešavati, klik odradi 

svoje i fotografija postaje crno - bijela.  

 

 

Slika 19. Crno – bijela fotografija 

 

 

 

 

No, ako fotografiju nismo prethodno doradili, ovaj način pretvaranja u crno bijelu fotografiju 

nije dovoljan. U nastavku će se prikazati princip pretvorbe na novoj nedorađenoj fotografiji.  
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Fotoaparat: Canon 30D 

Objektiv: 17-85 mm 

Vrijeme ekspozicije: 1/500 

             F: 20 

             ISO:100 

  

Slika 20. Originalna fotografija                          Slika 21. Primjenjen Desaturate 

 

Dinamika je nestala. Pri pretvorbi fotografije crno - bijelu fotografiju potrebno je podesiti neke 

parametre koji omogućuju pretvorbu boje u dovoljno različite tonove sive skale kako bi prizor 

bio zanimljiv. 

Proces započinje pretvorbom fotografije u Lab prostor boja (Image>Mode>Lab Color). 

Otvaranjem panela Channels (Window>Channels) vidljiva su tri kanala: Lightness, a i b. 

Kliknut je kanal Lightness, pa Image>Mode>Grayscale. Lab pretvorba prevodi boje u sive 

tonove procjenom njihove svjetline. 

Dobivena je fotografija kojoj će se još malo pojačati lokalni kotrast, zato će se kopirati 

Background sloj komandom Ctrl+J. Otvoriti će se panel Layers (Window>Layers ili F7) i na 

novom sloju primjeniti već spomenuti filter High Pass s radijusom 50 piksela 

(Filter>Other>High Pass). Način miješanja gornjeg sloja će također biti Overlay. 

 

 

 

 

http://www.fotografija.hr/slojevi-layers-1dio/733#overlay
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Krajnji rezultat je fotografija naglašenog kontrasta: 

 

Slika 22. Crno-bijela fotografija naglašenog kontrasta 

 

Ovim fazama prikazana je jedna od mnogobrojnih vrsta obrade digitalne fotografije. Svaka 

fotografija se razlikuje i tako će svaka njezina obrada biti drugačija i krajnji rezultati neće biti 

isti.  

 

 

3.2.Postupak kreativne obrade digitalne slike 

Kod kreativne obrade faze su puno kompleksnije od klasičnih obrada digitalne slike, pa će opis 

izrade ove fotografije biti u grubo i dosta kratko objašnjen na nešto jednostavnijem primjeru. 

Fotografija će se sastojati od više fotografija i njihovih dijelova. Kod ovakvih obrada autoru se 

osim izrade, dosta vremena oduzima za prikupljanje fotografija, izrezivanje segmenata, 

slaganje te finalna obrada za kvalitetan izgled fotografije. 
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Prvo što treba napraviti kod kreativnog postupka izrade slike je odabir fotografija ili elemenata 

od kojih će fotografija biti izrađena, zatim slaganje istih u određenu poziciju. 

 

 

Slika 23. Postavljanje kompozicije 

 

Fotografija se sastoji od više segmenata a to su nebo, more, stijena i svjetionik. Nakon 

pozicioniranja elemenata, potrebno je korigirati i doraditi neke dijelove koji daju do znanja da 

je fotografija sačinjena od više segmenata tj. treba izbaciti suvišne elemente te neke dijelove, u 

ovom slučaju more, duplicirati da popuni sliku. 

Kada su ubačeni svi dijelovi, kreće se na korekciju i dodavanje efekata. Najprije će se korigirati 

Curves te Hue/Saturation. U ovom slučaju takva vrsta korigiranja će se raditi na svakom 

segmentu drugačije osim na nebu i moru za koje će jednako vrijediti svi parametri. 

Pomoću Dodge Toola (Exposure na 15%, Size na 100 px i Hardness na 0%) će oblaci postati 

izraženiji na mjestima di su svjetliji; Clone Stamp Tool-a koji je podešen na Opacity 30% i 

Hardness na 0% kopirati će se valovi tako da zapljuskuju stijenu te dio stijene koji će se postaviti 

oko svjetionika da izgleda što prirodnije; Brush-a će se napraviti mali odsjaj u svjetioniku. 

Nakon toga, ako je potrebno korigirati će se kontrast ili svjetlina te ekspozicija. 

U završnoj fazi izrade se najčešće korigiraju elementi koji nisu dobro ukomponirani i stopljeni 

sa pozadinom, ili se dodaju još manji detalji kako bi završna slika imala više informacija, što 

može bitno utjecati na dinamičnost slike. 
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Slika 24. Finalna obrada slike 
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4. ZAKLJUČAK 

Primjena Photoshopa u digitalnoj fotografiji je među najnormalnijim stvarima današnjice. 

Koristi se za transformiranje originalne fotografije u nama željenu sliku. Obrada digitalne slike 

danas je vrlo raširen način izražavanja. Dakle, obradom fotografija se nastoji poboljšati 

fotografiju ili od više različitih fotografija načiniti potpuno novu. Takve obrade su 

prijekopotrebne da bi se dobio rezultat koji je potreban, a koji je nemoguće dobiti ili izmjeniti 

prilikom fotografiranja određenog motiva.  Osim toga, za dobru obradu digitalne fotografije 

potrebno je imati smisla za fotografiju, umjetnički talent te maštu za kreativne elemente. Obrada 

fotografija izvlači maksimum iz čovjekove kreativnosti i time on doseže nove razine vještina u 

tehničkoj i kreativnoj obradi neke fotografije te shvaćanje problema takvih projekata.  

Obrada digitalne fotografije je sama po sebi vrlo zanimljiva i na neki način unikatna, jer za 

izradu takve kvalitetne fotografije autor bi trebao spojiti mnoga znanja iz osnova digitalne 

fotografije tj. kako prvotno uslikati fotografiju te kako uopće koristiti fotografski aparat, trebao 

bi imati tehničko znanje o grafičkom programu, osnove digital painting-a itd. Za takve odbrade 

digitalnih fotografija potrebno je puno strpljenja i upornosti kako bi se došlo do što boljih 

rezultata. 
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